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Control measures

In determining the control measures to implement, the person 
conducting the business or undertaking must have regard to 
all relevant matters that may contribute to a musculoskeletal 
disorder, including:

•• postures, movements, forces and vibration relating to the
hazardous manual task

•• the duration and frequency of the hazardous manual task
•• workplace environmental conditions that may affect the

hazardous manual task or the worker performing it
•• the design of the work area
•• the layout of the workplace
•• the systems of work used
•• the nature, size, weight or number of persons, animals or things

involved in carrying out the hazardous manual task.

Code of practice: hazardous manual tasks
The WHS regulations determine that it is a legal requirement for the person 
conducting a business or undertaking (PCBU) and workers to address hazardous 
manual tasks in the workplace. A PCBU has a broad definition that includes both 
employers and supervisors.

The code of practice for hazardous manual tasks was developed to provide 
guidance on how to manage risks associated with those manual tasks with the 
potential to cause musculoskeletal disorders (MSDs).

A PCBU must consult with workers, so far as it is reasonably practical, to develop 
their own set of procedures to manage the risk of MSDs.

The hazardous manual tasks code of practice helps PCBUs and workers to:
• identify hazardous manual tasks
• assess the risks
• control the risks
• review the control measures.

Musculoskeletal disorders
MSDs come about in two main ways:
• Gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs

through repeated or continuous use of the same body parts, including static
body positions

• Sudden damage caused by strenuous activity or unexpected movements, such
as when loads being handled move or change position suddenly
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Screen

Once you have adjusted your chair and desk, you can position 
your screen. Adjust it so that the top of the screen is level with or 
slightly lower than your eyes. If you can’t adjust the screen to the 
correct height, place the screen on a platform.
The screen should be at least 50 centimetres or an arm’s 
length away from your seated position to minimise radiation 
exposure; however, you should always adjust the position of the 
screen to suit you. It is best to position the screen so that you 
can clearly read the text without leaning forward, twisting your 
neck, or looking too far upwards. Also take surrounding factors 
into consideration, such as reflection, glare and shadow, when 
positioning your screen.

Workstation features
The features of an ergonomic workstation are highlighted in the diagram below. 
Some features of the workstation may vary depending on the type of computer 
work being performed. Graphic work may require the use of a pen tool, and 
multiple monitors are commonly used for a variety of digital work.

Top of screen The screen angle should be adjustable between 85 and 125 
degrees to the horizontal. 

Centre of screen Minimise screen reflection and glare by using an anti-glare filter.

Bottom of screen Place a document holder beneath or beside the screen at the 
same viewing distance as the screen.

Top line of sight The viewing distance should be between 400 mm and 700 mm.

Bottom line of sight A relaxed viewing angle is approximately 35 degrees.

continued …
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Standing desk ergonomics
Using a standing desk for hours on end requires you to adapt. It is recommended 
that you start using a standing desk gradually by alternating between sitting 
and standing. You may experience sore feet, tired legs and fatigue at first. Wear 
comfortable shoes and use an anti-fatigue floor mat.

An ergonomically designed standing work desk means you can maintain correct 
posture while working. 

Position arms at 90 degrees when typing/standing.

Place the computer screen at eye-level and tilting it slightly upwards.

Place the computer monitor at least an arm’s length away.

Avoid leaning over the desk; keep your body straight. 

Monitor environmental factors
Environmental issues in the workplace include lighting, noise control and air 
quality. If the environment of your workplace is not monitored and controlled, you 
may suffer from headaches, fatigue, hearing loss or eyestrain.

Light

Good lighting is essential for a safe and hazard-free workplace. You need to see 
things clearly to work effectively. Simply shifting the screen slightly, adjusting 
blinds, altering the brightness settings on the screen and using desk lamps can 
avoid many light hazards. Try to use natural sunlight if the office layout can 
accommodate this. If not, keep bulbs and fixtures clean, focus light on your task 
and use fluorescent lights if possible.

Improper lighting can cause eyestrain and headaches.

Hazards associated with lighting include:
• glare – a computer screen positioned in front of a bright window can be

difficult to see
• flickering lights – a fluorescent light may malfunction, causing annoyance,

irritation and nausea
• inadequate or dim light – reading in dim light causes eyestrain
• reflections – sunlight reflecting on a screen can make it difficult to read
• shadows – shadows shifting across your work area can cause you to sit with

bad posture in order to read your work.
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Work without stress
Here are some tips for working without stress.

Tips to help minimise stress

•• Adjust your chair and desk to suit your body.
•• Position your screen to suit your posture.
•• Adjust other equipment for safe and comfortable use.
•• Reduce excess noise.
•• Ensure you have adequate light.
•• Arrange your desktop so you can access things easily.
•• Take regular breaks from your work.
•• Frequently rest your eyes.
•• Do stretching exercises.
•• Vary your tasks.

Practise conservation techniques
Conserving resources at work benefits not only the 
organisation by reducing costs, but also the planet by 
reducing greenhouse gases and the amount of waste 
sent to landfill. Most organisations have policies and 
procedures for conserving resources. You can find out 
what these are by reading your workplace manual or 
asking your manager or colleagues.

Ways to conserve resources at work include:
• minimising paper wastage
• reducing energy use.

Minimise paper wastage

Wasting paper costs organisations and the planet a great deal. Consequently, many 
organisations have developed policies for paper usage. These include:
• using both sides of the paper when photocopying
• recycling non-confidential waste paper in recycling bins
• storing email messages in an electronic folder instead of printing
• reducing the volume of printing where possible
• reusing paper by using blank sides for rough drafts and reusing folders

and files
• using recycled paper or paper from plantation timber for printed documents
• using a recycling service to collect waste paper.
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Organisational requirements for document type 
and style
Most organisations have requirements for the style in which documents should be 
presented. 

You need to be familiar with the styles used by your organisation for each 
document type. Some organisations have developed templates to be used for word 
processing documents. A template is an established style and layout model for a 
document.

Word processed documents used by organisations can include:
• memos
• faxes
• agendas
• minutes
• reports
• briefing papers
• flyers
• letters
• standard form letters
• mail merge
• labels
• envelopes.

Document templates
Templates can be formatted to any style your 
organisation prefers. Templates ensure that particular 
kinds of word processed documents are always produced 
in the same style. If you have to create a template for 
your organisation, make sure you ask your manager for 
advice about organisational style requirements. If your 
organisation has existing templates, make sure you know 
where they are stored.
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Minutes
Minutes are a written record of what occurred in a meeting. A list of participants 
is recorded as well as the details of all issues discussed. Minutes are written at the 
time of the meeting and are often placed on a server (a computer network) where 
all employees can access them. It may be your responsibility to write meeting 
minutes, so make sure you know where to find previous minutes. By looking at 
previous minutes, you will find out how your organisation prefers to have them 
presented. Look at the following example of meeting minutes.

Example: minutes

Minutes of the monthly meeting of the Equipment Committee of Engineering Forces 

on Wednesday 20 April at 2.00 pm at 237 Fraser Street, Belton

Present

G. Jones (Chair), L. Meadows, D. Juntovski, J. Crance, A. Andrews, S. Tran, H. Roberts
Apologies

J. Rostova
Minutes of the previous meeting

The minutes of the previous meeting were confirmed and adopted as an accurate 
record.
Correspondence

A letter was received from Century Computers ordering two computers and a modem.
A letter was sent to the Royale Receptions Centre requesting information on facilities.
Reports

G. Jones reported that the consultant from Eagle Consultancy had completed a
report on the computer needs of the company. The findings will be summarised and
distributed to all staff members.
Action: H. Roberts to prepare a summary and distribute to staff within a week.
J. Crance presented the financial report on spending for March. Major items were the
coffee maker and filing cabinet. The report was accepted.
A report from the Occupational Health and Safety Officer was tabled and discussion 
deferred to the next meeting.
Other business

D. Juntovski reported that the printer had consistently broken down during the previous
three weeks and requested that the cost of getting a new printer be investigated. The
meeting discussed the possibility of obtaining a second-hand printer.
Action: A. Andrews will obtain costs for a new printer and a second-hand printer from a 
range of suppliers and report at the next meeting.
Next meeting

The next meeting was set for Friday 29 April at 2.00 pm.
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Create a letter
In the following exercise, you are required to create a letter using a Word Letter 
template.

1. Open Word.

2. In Search, type ‘Letter’ and press enter.

3. Choose an appropriate Letter template from the online template list.

4. Select Create.

5. Spend 30 minutes composing a letter on a subject of your choice. Save your
letter as MyLetter.
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Word process an address on an envelope
In the following exercise, you will word process an address for an envelope.

To add an address to an envelope, you are required to use an existing letter.

1. Open your MyLetter document.

2. From the Mailings tab, it is possible to choose either the Envelopes or Labels
button. For this activity, select Envelopes. The recipient’s address that you
typed into your letter should appear in the Delivery address box. Look at the
following example of the dialogue box to help you.

3. Under Return address, enter a return address (your organisation or home).

4. If you want to change the size of the envelope, click Options. Click Envelope
Options and enter the correct envelope size. Click OK.

5. To print your envelope, place an envelope in the printer and click Print. Make
sure the envelope is inserted the right way. Close your MyLetter document.
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Practice task 3
Read the case study, then complete the questions that follow.

Case study

Isabella completed her studies in human resource management and gained a 
position as a human resources officer with a large multinational company. After 
working in the position for approximately six months, Isabella had impressed her 
supervisor and manager with her dedication and enthusiasm. As a reward, they 
asked her to manage a project of creating a new induction resource pack for new 
managers at the organisation. 
In her project brief, she was asked to include information on the role of human 
resources and the importance of line managers interacting with human resources 
for advice and guidance on workplace issues. At first Isabella wasn’t sure how 
to tackle this assignment; however, she investigated trade journals and various 
textbooks, along with the HR policy manual. Isabella located three relevant trade 
journal articles and some information on decision-making models from textbooks, 
which she believed would complement the information she had sourced from the 
HR policy manual. Isabella set about word processing the articles and models to 
make them look more appealing. 
Once complete, she signed off each document with ‘by Isabella Gonivici’. Isabella 
did not reference the articles or textbooks and did not state who had researched 
the models. In a brainwave, Isabella decided to send regular customers details of 
new managers’ after hours home phone numbers just in case they couldn’t reach 
them during the day. She thought this would complement the organisation’s policy 
of total customer service. Isabella was pleased with her work and was looking 
forward to the accolades that would follow from her supervisor and manager.

1. Were there any possible copyright infringements in Isabella’s completion of the task?

2. Were there any content restriction issues?

3. What should Isabella have done differently?
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Select paper size, source and orientation
1. In your MyLetter document, select the Page Layout tab and select the Size

button. Make the appropriate choice for paper size.

2. From the Page Layout tab, select the Orientation button. Select Portrait from
Orientation. This means that the height of the document is greater than the
width, like a portrait painting. Landscape means the width of the document is
greater than the height, like a landscape painting.

3. Save and close your MyLetter document.

Experiment with these options and view your document by going to File, then 
Print to see the results of your choices. If you are unhappy with your choice, you 
can undo it by using the Undo button.

Paragraph formatting
Most word processed documents are written in paragraphs and you need to 
know how to format paragraphs in accordance with your organisation’s style 
requirements. Paragraph formatting includes indents, spacing, and line and page 
breaks. 

Set indents and spacing
1. Open your MyLetter document.

2. Look at the paragraph formatting tools on the Home tab and Page Layout
tab, including Bullets, Indentation, Sort, Show/hide paragraph marks,
Alignment, Line spacing, Shading and Borders.

3. The indent of a paragraph is how far it is positioned from the margin. From the
Home tab, use the Increase Indent button or Decrease Indent button to move
the paragraph forward or backward.

4. Alignment controls how your paragraph text will appear. You can choose
to align your text left, centred, right or justified. Select an alignment for your
text.
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3. In the Password box, type a password and click OK.

Protect Document will now be highlighted in a yellow block. 

4. In the Confirm password, re-enter the password and click OK.

5. Save and close your MyLetter document.

6. Reopen your document using your new password. Close your document.

Columns
Creating columns for some documents can be useful for presentation. Columns 
are commonly used for newsletters, reference manuals and other documents where 
you want to alter the way the information is presented. Using columns allows you 
to flow the information on a page into a series of columns, similar to that of a 
newspaper.

Corporate letterhead/logo
For many documents, such as outgoing official correspondence, it is necessary to 
use letterhead. Some organisations use pre-printed letterhead, and you will need to 
ensure that the appropriate spacing and margins are used to allow for printing on 
the letterhead. If letterhead is commonly used, you may also find that your office 
uses a set printer tray for letterhead.
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Page numbering
Page numbering is commonly used in longer documents, such as reports. It 
may also be used in outgoing correspondence, such as letters. Page numbers are 
placed in the margin of the document by using the Page Number button via the 
Insert tab.

There are a number of options for where the page number can be positioned, such 
as left aligned or right aligned. It is possible to manually manipulate it further via 
the header and footer; for example, to add the word ‘Page’ before the number.

Tabs
Tabs are commonly used to position text horizontally on a page. Using the tab stop 
on the keyboard allows you to tab the text approximately 1.25 cm at each stop – 
this is the default option. Alternatively, it is possible to use the ruler to place the 
tab stop at the required position. Tabs can be aligned right, left, centred or at the 
decimal.

In the following exercise, you will practise using tab stops.

1. In your MyFax document, if you do not have the ruler in view, select the View
tab and check the Ruler.

2. Click in a paragraph in your document.

3. Select the alignment of the tab stop using the type of tab stop on the left of the
ruler  . Each time you click a different alignment option is selected.

4. If there are no tab stops, click into the ruler where you want the tab stop to be
positioned.

5. To remove a tab stop, simply drag it off the ruler.

6. To modify a tab stop, such as to add a leader (a dotted or dashed line), simply
double-click on the tab stop on the ruler. Make alterations using the following
dialogue box.

Click OK, then save and close your document.
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Web Layout 

Enables you to view the document as you would view a web page. 
Page breaks, page margins and headers and footers are not 
displayed. Some people have a personal preference for working in 
this view as it has a focus on the document content.

Outline 

Allows you to view the document in outline form. This is useful 
for longer documents or reports where styles are used much 
the same as chapter headings. The Outline view allows you to 
manipulate blocks of text. In this view, you are automatically 
prompted to use a new set of tools under the Outlining tab.

Draft

Enables you to work within the document to make necessary 
adjustments to text and content. Page margins and headers and 
footers are not visible.

Zoom options
To make documents easier to read on-screen as well as to check the overall layout, 
there are various zoom options available for use. You might want to zoom in and 
increase the size of the document to see text and objects more clearly. You might 
want to zoom out and decrease the size of the document in view to analyse the text 
layout and overall document presentation.

The zoom control at the bottom right of the screen can be used to quickly adjust 
the zoom view of a page. Simply move the control up or down to change the zoom 
size of the document.
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You may need to access help when producing word processed documents. You may 
not understand how a word processing software function works, or you may need 
help operating a printer. Whatever the problem is, you need to have a plan in place 
for dealing with the unexpected. Organisations usually have a number of ways of 
dealing with software or hardware problems. They may have manuals or training 
booklets for you to look at, or they may have set up a help desk.

Using Word Help
If you are working in Word, you can use the Word Help facility . Full access 
to the help facility requires that you be connected to the internet. It is possible, 
however, to access standard help facilities offline. To use this facility, simply click 
on it and either use the chapter index or type in a keyword for the help you need in 
the Search bar.

You can also use F1 to access the Word Help facility.

You can find out more about specific formatting of an on-screen document 
by using Shift F1 on the keyboard. This will display character and paragraph 
formatting.

2C	 Overcome problems with document 
presentation and production
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This learning checkpoint allows you to review your skills and knowledge in 
producing documents.

Part A

Imagine your workplace or school is about to have an afternoon of activities to 
help people learn to deal with disagreements. You have been asked to word process 
a flyer that will be distributed to advertise the event. You can use the topics below 
for the activities or make up your own topics. Make sure you add the date of the 
event and where it is to be held. When word processing your document:
• use word processing formatting options to communicate your message as

clearly as possible
• as required, use screen display options and controls to assist in working with

and viewing the document
• use help facilities if needed
• proofread your document to check for errors
• preview your document before printing it
• save your document as ManagingDisagreementsFlyer and store it safely.

Topics (optional)
• Managing disagreements
• Handling arguments with friends
• How to break down the wall of silence
• Uncovering the true source of your arguments
• Methods for discussing your differences
• Ways to achieve meaningful discussions

Part B

In this activity you are required to use your ManagingDisagreementsFlyer to word 
process a report. Write one paragraph for each topic you have advertised on your 
flyer. Use any online or paper-based help resources available to you to compete 
the task.

Learning checkpoint 2 
Produce documents
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Ensuring that you produce quality documents that adhere to organisational 
and task requirements is important. Thoroughly checking and proofreading a 
document before sending is necessary to ensure the correct message and corporate 
image are being delivered to the appropriate people. For example, if you have 
not spell checked a document and it contains errors, or if you use the wrong 
letterhead, it sends an invisible message to the receiver of the document. They may 
think that you, and your organisation, don’t really care about the content of the 
document.

When preparing documents, it is important that you adhere to the required time 
lines and job instructions. If you believe there needs to be alterations to either the 
time line or job instructions, you will need to discuss this with your supervisor. 
Many businesses have strict deadlines for completing tasks – it may be that 
documents or reports are required for signature by the end of the week. If you fail 
to meet the deadline and don’t send out the required documents or reports, it may 
affect other tasks.

In this topic you will learn how to:
3A	 Preview, check, adjust and print a final document
3B	 Prepare documents within time lines and requirements
3C	 Name and store documents, and exit the application safely
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Print a document
In the following exercise, you will print a document.

1. Open your MyLetter document.

2. Select the File tab, then Print. If you are unhappy with the preview, click the
back arrow  and modify your document.

3. From the File tab, select Print. You will see a Print dialog box similar to the
following.

4. Under the Printer heading, select the appropriate printer.

5. Under Settings, select Print all Pages. By selecting this, you will print the
whole document. You can also choose to print selected pages from the
document by entering page numbers into Pages; for example, 3-9 would print
pages 3 to 9.

6. From the Copies box, select 1. You can change this option to print multiple
copies of the same document.

7. From Print All Pages, you can choose to print only the odd or even pages.
Click Print to print your document.

The Collated option controls the order in which multiple-page documents are 
printed. For example, imagine you want to print two copies of a three-page 
document. If you choose Collated, Word will print the pages as follows: page 1, 
page 2, page 3 of document one, then the same for document two. If Collated is 
not chosen, the two documents would print page 1, page 1, page 2, page 2, page 
3, page 3.
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Name, store and close documents
When producing word processed documents, you need to be aware of how 
to name them and where to store them. All organisations have policies and 
procedures for naming and storing documents. Ask your manager to explain your 
organisation’s requirements. Documents can be stored in soft or hard copy. This 
means they can be stored electronically in a computer or in paper-based form in a 
filing cabinet.

Some organisations have strict naming standards that must be adhered to, such as 
all project files having to start with PRO. Another example is using client reference 
numbers rather than names. If there are many clients with the same surname, a 
unique reference number will avoid confusion. Find out the naming standards for 
folders and files in your workplace or place of study.

Digital storage
Paper documents can become damaged, yellowed and brittle. In addition, unless 
you are very careful about storage and use, important documents can be easily 
torn, misfiled or accidentally disposed of. Storing many documents can also be 
expensive and some organisations prefer to store information digitally. Digital 
storage saves on paper and space.

Another advantage of storing documents digitally is that powerful databases 
can be used to search stored information. Databases enable you to find specific 
information that would be much harder to find by searching through hard copies 
of documents. Databases also provide management with powerful metrics and 
reporting tools. For example, 
statistical information can 
be gathered from a database, 
and detailed reports can be 
produced.

In many organisations, folders 
and files are stored on servers. 
Deleting old electronic files 
and folders needs to be done 
regularly to ensure an efficient 
use of server space. Always 
ask for authorisation before 
making any deletions.

Folder structure and naming standards
Folder structure and naming standards are needed to allow staff to set up folders 
quickly and easily. Shared directories are folders on a network that a group of 
people have access to. 
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… continued

Use virus protection 

└└ Other causes of data loss include virus damage, operating
system or application software bugs and failed upgrades. Using 
virus protection programs and frequently updating software can 
help prevent data loss.

Prevent computer malfunction

└└ If your computer starts to make unusual noises or display warning
messages, shut it down immediately and do not turn it back on 
until you have received advice from an IT coordinator.

Use the correct application exit procedure

└└ To exit the program, select the exit button, which is located in the
top right corner of the window. If you have recently made changes 
to your document, you will be prompted to save changes.

Practice task 9
Read the case studies, then answer the questions that follow.

Case studies

Matthew works as an office administrator in a large organisation. His duties 
include formatting reports and saving them on the server. He is also responsible 
for backing up the server at the end of each day. At the end of a busy day, Matthew 
had completed several reports for different departments within the organisation. 
He had to save each of them in a different location, and it took him a while to work 
out where they all belonged. He wasn’t sure if he had saved them all in the correct 
place. After this, he was running late and decided not to back up the server. The next 
morning, the reports that Matthew had saved were needed for an important board 
meeting. However, during the night a virus had infected the server, destroying all the 
information from the previous day.
Fred has retired from an organisation after working as an administrative assistant for 
10 years. The areas Fred was responsible for were accounts and projects. The day 
after he retired, someone needed a file that Fred had created and stored. The file 
contained vital accounting information. It was discovered that Fred had saved more 
than 500 files in a variety of folders and the file could not be located. The folders 
had ambiguous names such as Folder1 and Folder2 and the files had names such as 
august1.doc and march2.doc.

continued …


